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A letter direct from the editor desk highlighting on August’14 edition
We have published the August issue of our esteemed magazine. Each and every issue of the magazine facilitates the
readers to keep abreast of recent industry trends in sketchup and 3d world.
Sketchup-ur-space is a trustworthy and well-respected source of brainwave for worldwide sketchup professionals. Every
issue of our magazine features in-depth tutorials, articles, cover stories, interviews, community news, stunning 3d images
etc. based on sketchup.
In this current edition our in-house editorial team has published an exclusive cover story on 3d printing with sketchup.
Sketchup is a great application to design models and make them 3d printable. Sketchup allows users to create perfect 3D
prototypes.
In article section, there are four outstanding articles and all are presented by our in-house editorial team. The first article
focuses on how to create 3d modeling design with polymide material. The readers can get brief insight into polymide 3d
modeling.
The second article is about layout dimension tool inside sketchup. The readers can learn how to apply angular dimension,
edit it as well as modify dimension elements.
The third article focuses on behind the scene story of 3D printing. The readers can learn how it originates as well as gradual
evolution of 3d printing.
The last article opines on theory of 3d modeling. The readers will be familiar with types, the process as well as various
useful 3d modeling applications.
In tutorial section, our readers will get some useful & instructional tutorials provided by some renowned 3d modeling
professionals.
The first tutorial is presented by Justin Geis, the founder of sketchup essential. In this tutorial, Justin briefly shows how to
apply sketchup for modifying 3d shapes through scale tool.
Laurent Brixius, the renowned Belgian architect and author, presents two useful tutorial. The first one explains the
functionality, application & usefulness of various sketchup components. The second one focuses on how to fix and optimize
existing existing components to make them quickly and easily reusable for your projects.
The last tutorial is presented by Andrew Jones, a promising IT professional and designer. With this tutorial, Andrew explains
how to apply slicemodeler plugin within sketchup to generate laser cut 3D shapes that snap together without glue.
In interview section, we have arranged an interview with Mario Goles, the leading architect, interior designer and 3d
visualize. Mario briefly analyzes the role of sketchup in his professional life.
In news and review section, the readers will keep abreast with latest trends and happenings in 3d modeling as well as 3d
printing worlds.
Hope our readers will enjoy this issue to a great extent.
If you have any queries concerning publication, subscription, troubles navigating the site, please mail us at
rajib@sketchup-ur-space.com

Best wishes
Rajib Dey
Editor
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Interview with Mario Goles - Designer at Sketchupartists and Interior
Designer/3d Architectural visualiser at Freelancer
Hello, Mr. Goles. Welcome to the world of sketchup ur space. Please introduce yourself to our
readers.
My name is Mario Goles. I am from Croatia, beautiful country in Europe, situated on the Adriatic sea.
For several years now I do Architecture and Interior design, using different 3D modeling tools and
other more sophisticated software for completing my projects.

When did you first discover sketchup in your professional career ?
I must say that at the very beginning, I have started 3D modeling using 3DS Max. Which is very good
tool in so many ways. But very soon I have discovered that even though has many nice features,
there are some which are missing in order to do my interior projects completely and professional. As
an interior designer it is not enough to do only nice 3D visualizations in your projects, but also it
requires a lot of technical documentation. So very soon, I have found that SketchUp Pro is the only
tool that besides creating photo-realistic 3D visualization, meets all the stages of preparation of
interior design project documentation. For very cheep licence price compare to the other software
packages.
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You perform as the Designer at Sketchupartists. Please tell us something about your
professional career.
I must say that many years ago when I have finished my education, it was not for interior designer or
architect. I graduated for IT scientist and worked from many years as Software Architect. Leading
many national and international software teams, covering any size of projects. But as I grown up next
to my father who is as Architect, somehow I always had it under my skin. So more then ten years ago
I decide to change my profession and career even though I was doing well in IT industry. I finished
schools for Interior designer, many courses and trainings for 3D Design as well as collecting
professional certificates on this field. During years I have dignify my knowledge working with many
architects and interior designers on many different projects, and now I love what I do, enjoy designing
and looking forward to enjoy some more.
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As an interior designer how do you evaluate sketchup ?
I have found SketchUp as a really great tool for interior designers. Especially because it offers most
of the tools which are necessary for completing all stages of an interior design project. Integration of
Layout within SketchUp Pro, is mandatory in order to do your projects in a really professional way
with all required drawings, plans, section cuts, elevations, etc. SketchUp Pro really offers all this
possibilities in a very intuitive and easy-to-do way. Also there is a great 3D warehouse, which offers
unlimited number of different 3D objects, easy to download and import into your SketchUp model.
Furthermore I have to mention a huge number of SketchUp plugins which are available to download
from new SketchUp Extension Warehouse. Very useful in order to make your workflow even more
easier. Some of them are free to download, others require some payment. But if you find a plugin that
will make your work much easier and reduce the time of completing your projects, I definitely
recommend investing in it.

The most updated version of sketchup is sketchup 2014. How it facilitates your workflow?
New version of SketchUp Pro brings many new features, but one which I would evaluate as most
useful for me and I believe for other Interior designers as well as for Architects, is implementation of
"Classifier". Classifier, enables me to enrich my model with important metadata and improve its
compatibility with other building information modeling (BIM) tools, like Revit Architecture for example.
It also tags geometry with industry-standard object types like walls, slabs, roofs, and hundreds more. I
have to mention new feature of implementing "Smart Labels" as well. This is very helpful tool that
allows automatic population of labels with pre-populated relevant text. So when you label a group or a
component, its name appears. Labeling a face displays its area, labeling an edge provides its length,
and labeling a point yields its coordinates. Very often in first stages of a project, showing such
information is very useful.
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V-ray is a useful tool for superior architectural visualization & rendering. Please share your
views.
I have tried many rendering engines for SketchUp in order to get photo-realistic visualizations and I
must say that only V-Ray is the one that I would consider as serious render. There are others of
course, which can produce nice visualizations, very realistic ones, but in general we have to consider
all the other aspects of rendering engine. V-Ray for SketchUp offers many new features that makes
my work easier and in every stage of my projects. For example. with new Batch Render tool I can
now render all SketchUp scene tabs with a single click. So I don't have to sit down next to the
computer waiting render to finish to be able to start a new one. I just leave my computer to do the job
over night and in the morning I have all my renders ready. During design process, very often I discuss
with my customers about many aspects and details in order to achieve augured visualization result.
When it comes to that, new V-Ray RT feature is a prefect tool which has been optimized for a more
interactive experience and enables me to do my job much faster and easier then ever before. This
revolutionary rendering engine streamlines scene setup and provides instant visual feedback directly
in SketchUp for quicker design, shading, material, and lighting decisions. There are some other VRay features which helps a lot in order not only to get my visualizations realistic and fast rendered,
but also enables me to work with my SketchUp model much easier and faster. One of them is V-Ray
Proxies. Within its improvements, V-Ray manages scene memory and efficiently renders large
amounts of geometry to increase detail and complexity in scenes. V-Ray Proxy objects are
dynamically loaded and unloaded at render time, which saves vital RAM resources and of course
enables working with big SketchUp models much faster and easier. Especially in combination of new
SketchUp casting shadows improvements.
Furthermore I must not forget a Dome Light, witch creates simple, artifact-free image-based lighting
using importance sampling of HDR images. This technique greatly optimizes light tracing and global
illumination precision, witch makes my visualizations even more realistic. Beside all mention, there
are so many other V-Ray tools which in general makes V-Ray as my first and only choice of rendering
engine for SketchUp.
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Do photorealistic visualizations and the method they are presented on the internet transform
the way people recognize architecture ?
Of course. There are so many people which doesn't have this possibility to visualize a 3D space
based on 2D drawings or some other sketch. Photorealistic visualizations allows them to see how the
things will look like even before they have been made. In today’s visually oriented, hightech society,
people expect information to be presented in more advanced and visual ways. People will engage
more when viewing photorealistic scenarios and are drawn to the opportunities to interact with
computer-generated visualizations. On the other hand, Architecture as well as Interior Designing has
been widely discussed and the rendered image has been lambasted for perpetuating the notion of
style over substance and image over experience. I even sometimes get people, possibly being
tongue-in-cheek, saying, "you don't need to go though the hassle of building that, you've got the
pictures already." It's a difficult one as even though I like to think I interrogate interior designing, I still
regularly find myself flicking through a journal or website and only stopping when I'm seduced by an
easily accessible sexy-looking image.
Are there specialty software programs for interior design professionals? If so, what are they
and what do they do ?
here are many specialty software programs for interior designing as well as for architecture. I always
combine these two as they are really much related to each other in several project stages. But the
problem that I have found out working with different software programs, is that almost non of them
offers complete set of tools necessary to do my projects complete in every stage. You see, as I
mentioned before I did start to do my first visualizations in 3DS Max. And I really do like to work with
this software, even more then with SketchUp. It offers much more tools for modeling, V-Ray for 3DS
Max has much better rendering options, even visualizations looks somehow nicer. Rendering process
is faster compares to the same in SketchUp, and so on... But the first problem working with 3DS Max,
which I have found as interior designer, come up when I had to do dimensioning. 3DS Max doesn't
have possibility to produce technical documentation (flour plans, section cuts, elevations, lighting
fixture micro-locations etc.), and this is very important part in completing interior design project. So I
had to combine it with some other software. In most cases this is Revit Architecture. When it comes
to Revit, I truly believe this might be next generation interior designer's tool. This software is so
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intuitive and easy to use, offers most of the tools an interior designer will need in order to complete
his projects. It has BIM technology integrated much better then SketchUp. As a matter of a fact,
SketchUp's "Classifier" is more like tool which helps Revit to recognize and organize SketchUp
objects as proper BIM objects, once when they are imported into it. Possibilities of BIM technology in
SketchUp is not even close to the one in Revit. Also more and more companies are offering very
detailed free to download BIM objects for Revit on their official web pages or on some other BIM
warehouses. But then, when I have to model particular sofa or a lounge chair, it's very difficult to do it
in Revit, so I have to use some other modeling tool. Also, event though Revit has rendering engine
integrated, it is slowest rendering engine I have seen, and to achieve photo-realistic visualizations in
Revit, look like in 3DS Max or SketchUp, it's almost impossible. Of course there are always ways to
do it, perhaps using Autodesk Cloud rendering, but still, there are always pros and cons. Anyway, by
now for more complex projects I use Revit Architecture in combination with 3DS Max + V-Ray as
rendering engine. And this is really great workflow. But then when you compare the licence price for
these three products with the SketchUp + V-Ray licence cost, it really rises a question "...which one to
use?", as with SketchUP Pro + V-Ray I can achieve the same results as with Revit + 3DS Max + VRay. Problem is that each of mentioned software has been initially made for something else. During
years they all have been upgraded to user's needs and requirements, but buy now non of them fulfill
requirements of an interior designer. Once when we would have a software which will offer a power of
Revit in technical drawings, BIM technology and making of technical documentation, power of 3DS
Max in modeling and rendering, and power of SketchUp in easiness and intuitive of use, for the
SketchUp price, then I would be able to say this is a perfect tool for me as an interior designer. Buy
now I see Revit as closest one to achieve this point. Only thing that is missing is V-Ray render for
Revit and some modeling tools. I truly hope people from Autodesk are looking forward to produce
such software in near future. New versions of SketchUp of course could reach this point as well, but
as by now I think SketchUp needs much more improvements in several fields. There are other great
software as ArchiCAD, C4D and others, which I have to mention as well. Even though I haven't been
using them much, but I know from my friends who do, non of them also offers a complete solution for
interior designers. Anyhow, at the moment SketchUp is the only one that offers me most complete
solution to do my interior design projects, in a fast, easy and professional way. But, I was always
saying, the best product is the one you know the best, and you should stuck to it.

You completed several projects with sketchup and which one was most successful & which
one was most challenging.
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Each project was a challenge for itself. But from interior designer point of view, maybe I can single out
projects that ware requiring full functionality in a relatively small space, like kitchens for example. On
the other hand from 3D designer perspective, most challenging projects ware the once that required
modeling of particular organic shapes as well as usage of complicated lighting techniques in order to
achieve maximum realism. Anyhow I think that by now, every project of mine was successful, as
investors ware happy with what they get for their money.
What up-gradation should be included in sketchup and v-ray in near future ?
As I have mention before, I would like to see in future versions of SketchUp, much better BIM
technology integration, something like in Revit Architecture. Also would be nice to improve Layout
tools in order to make architectural documentation easier and more intuitive to architects and interior
designers. For example to be able to do nice section cuts with different hatches instead of working
around with different view styles and spending time on other workarounds. Actually there are lot of
nice SketchUp plug-ins that helps architects and interior designers in achieving augured results, but
the problem with them is that very often they are not updated on a regular basis. Even worst, for
some of them nobody knows if they would be developed further more, as they are not part of Trimple
SketchUp. So it happens when new version of SketchUp is published, not every plugin is compatible
with it any more, and we have to wait for updated version. Sometimes we do not have time to wait for
it and if we really relay on this plugin we have to stuck with the previous version of SketchUp. There
fore how ever plugins are useful and solve many problems, makes interior designer's life easier, I try
to avoid them for many reasons. It would be nice to have something like "SketchUp for Interior
designer's" package, which would include all necessary plugins as regular tools of SketchUp instead.
I know this is not possible as policy of Trimble doesn't work this way, but that's something I would like
to see in the future. When is about V-Ray for SketchUp, there is not much to say, except that I would
like it to have all features like V-Ray 3.0 for 3DS Max.

If anyone wants to pursue a career in Interior Design, what types of degrees are required ?
It is really difficult for me to answer this question as I talk to many interior designers and architects all
over the world, and I found out that in different countries different degrees are required. But anyway,
what ever is required I believe that as much knowledge and experience you can collect, it's better and
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it will make you better architect or interior designer. So what ever school, course or training you can
achieve and finish it's only better. From my experience, beside every education I have finished as
well as many courses, I did learn much from thousands of tutorials which anybody can find on
youtube, forums or some other web locations. Use them, they are very useful and will give you an
answer on many questions you can not find in any book or any school. Share you knowledge and
experience with others, and it will be gratefully returned favour.
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The users of AutoCAD Architecture can get assistance from SketchUp
There are some third party tools, which always help all aspects of drawing quality. SketchUp plays here for
AutoCAD Architecture. Using the SketchUp, a designer can see is how user-friendly is this application.
AutoCAD Architecture (abbreviated as ACA) is a version of Autodesk's flagship product, AutoCAD, with tools
and functions specially suited to architectural work. On the other hand, the SketchUp (Formerly: Google
Sketchup) is a 3D modeling program for applications such as architectural, interior design, civil and mechanical
engineering, film, and video game design. A freeware version, SketchUp Make, and a paid version with
additional functionality, SketchUp Pro, are available.
The free download includes integrated tools for use in uploading to Google Earth. SketchUp is part of the same
product family as Google Earth. With this tool, Designers can import a scaled aerial photograph from Google
Earth to SketchUp with the click of a button. This can include topographical information as well. The SketchUp
Pro comes with Layout, which is a 2D companion to SketchUp Pro. With Layout, you can create professional
design documents, dimensioned drawings, and presentation documents from the 3D models you created in
SketchUp Pro. When the model updates in SketchUp Pro, the changes would automatically updated in Layout.

If you are a new user of SketchUp, then get rid of worry
SketchUp is not a headache for the new beginners. Therefore, do not lose your sleep. There are help menu,
help centre, SketchUp Reference Guide, quick Reference Card where a user can print a PDF showing helpful
shortcuts. There is a link for SketchUp as well as a link for Layout. Here are a few helpful tips to help uses get
started.
•
•
•

When using your mouse, the left button is for tool operations and the right button is for the context
menu.
The middle button (wheel) has several functions: click and drag to orbit, shift click and drag to pan,
double click to re-center your view, and scroll to zoom.
The spacebar operates the Select Tool. You can use ctrl spacebar to add to a selection set, shift
spacebar to toggle in and out of a selection set, ctrl A to select all, and shift ctrl to subtract from a
selection set. Finally, please print and read the Quick Reference Card before proceeding to use
SketchUp.

File Formats
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One of the many features of SketchUp is that it uses a wide variety of file formats in the likes of DWG, DXF,
OBJ, FBX, XSI, and WRL. If the users do not want to take the time to import a file into ACA, they can also
create a screenshot of the file and save it in BMP, JPG, PNG, PDF, EPS, and TIF formats for presentation
purposes.

How ACA file to import into SketchUp ?
Importing ACA file to SketchUp is not a big deal for the designers. All the designers have to do is to know the
basic feature of SketchUp. This process will be much easy if these are possible.
•
•
•
•
•
•
•

Let us begin by opening SketchUp and Select the file Menu.
Select the import.
User can see the option button, under the preview area.
Select options and then select the options that need in the dialog box that opens.
Click OK.
Now select the file that you wish to import and click open. If you do not see the file you are looking for,
be sure to click on the drop-down next to File Type to ensure that you are searching for the correct file
type.
Congratulations! You have now successfully imported a drawing into Google SketchUp! It is important
to note that the SketchUp file will have the same 0,0 origin as your AutoCAD Architecture drawing.

Now a designer can take his/her drawing into SketchUp, let us make the 2D walls to 3D.
•
•
•
•
•

The designers should begin it by right-clicking and selecting Make Group.
Then select the Line tool and select any corner of the perimeter to start the line.
Now, enter the wall height in the Measurements box and press enter. Next, select the Rectangle tool.
Begin your rectangle by selecting the endpoint of the line you just drew and end the rectangle at a point
on the wall. Continue it until all exterior walls are erected. The designers will definitely found that it is
easier to form the exterior first.
Now that all exterior walls have been erected and closed, the designers have to create a face. The face
is used to build the roof once you are ready to do so. Next, select the face, select the Offset tool and
enter the thickness for the exterior walls you have just created. Now select the face and use the
Push/Pull tool. Push the face down to create the interior face of the walls. This will develop the interior
face of the exterior walls so that you can continue to create the interior walls at this point using the
steps above.
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Doors and Windows are added
Therefore, after the creation of walls, a designer will need to decide other important things such as header
heights, doors and window sizes and styles. Once you are ready, be sure you are in X-ray mode. Now the
designers have to insert the door component you selected and place it by referencing a point on an opening in
your imported AutoCAD Architecture file. Then he/she have to keep continuing the placement all door
components using X-ray mode. Next place all windows using the same method stated above for door
placement. For example, if designer are going to place a window component above an overhead door, he/she
will reference a point on the window and a point on the door.

Model in 3D
A camera is used by SketchUp to represent user’s point of view of the model. You are a camera that is looking
at your model as you work. SketchUp uses several tools for viewing your model in 3D space. These are tools
familiar to you in AutoCAD Architecture: Pan, Orbit, Zoom, and Zoom Extents. Each of these tools can be found
on the Camera toolbar.

Dynamic Components
Dynamic Components can be defined as components that have parametrics. For example, a cabinet
component has doors that open and close. A component is only considered dynamic when it has parametric
data. Dynamic components will display with a special badge when parametric data is present. Attaching
attributes to a component is what makes the component dynamic. Attributes are items such as the component's
name, description, location, size, and number of copies. Some attributes are predefined, which means that they
are automatically available for every dynamic component. There are also custom attributes that are unique
attributes defined by the developer of the dynamic component.
Every attribute of a component has a value that can be a textual string, a number or the result of a formula.
Each attribute and its associated value is called an attribute name/value pair. Formulas can consist of
predefined functions, mathematical operators, or the values of other attributes. Functions are shortcuts that
perform an operation, such as calculating the square root of a number. It is important to note that all SketchUp
users can use dynamic components. However, only SketchUp Pro users can develop dynamic components.
To make a component dynamic, right-click on the component, select Dynamic Components, and then select
Component Attributes. Select Add Attributes and a dialog box will display with attributes that can be added to
your component. Once you have added the attributes, the new dynamic component can be saved to a
component file for additional use later.

How to export a SketchUp File, into AutoCAD Architecture ?
Exporting a Google SketchUp file into AutoCAD Architecture is same easy.
•
•
•
•
•

Once you are ready to export, select the File menu and select Export.
Next, select 2D Graphic or 3D Model, depending on the file you are exporting.
Select the export file type from the drop-down. You are exporting to AutoCAD Architecture, so you
would select AutoCAD DWG.
By selecting the Options button at the bottom, you can choose which AutoCAD version you are
exporting to as well as the drawing scale and size.
Select OK and then select Export. The export is now complete! It is important to note that you can
alternate between ACA and SketchUp multiple times. Your drawing does not have to be complete
before importing it into SketchUp or from SketchUp into ACA.

The use 3D Warehouse and it is free
The 3D Warehouse (formerly Google 3D Warehouse) is an accompanying website for SketchUp. It is a free
cloud service that allows users to search, upload, download and share 3D models. The site enables modelers
to upload their work from within SketchUp or by uploading .SKP or .KMZ files via the 3D Warehouse website.
The 3D Warehouse currently holds over 2 million models. Individual models can be viewed in 3D on the web
using a modern Internet browser that supports WebGL, or with the SketchUp Mobile Viewer application
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compatible with current iPad devices. Users can search and download models from 3D Warehouse from a web
browser or from within the SketchUp desktop application. In 2008, PC World reported that 3D Warehouse
allows users without significant artistic inclination to make and populate 3D models. Also in 2008, The New
York Times reported that the 3D Warehouse had become a virtual ‘dictionary’ of the 3D vocabulary, reporting its
suitability in filmmaking.
A great feature of SketchUp is the 3D Warehouse, which allows you to search for 3D models made by other
users as well as contribute 3D models of your own. It contains 3D models of buildings, cars, bridges, interior
furnishings, and much more. A new feature allows you to search for similarly shaped models instead of relying
on a text search. This really saves time when you are in a hurry to find a specific item. The 3D Warehouse is a
wealth of information and can help you design quickly when facing a tough deadline.

Layout Tool
The SketchUp contains a vast library of colors, textures, shadows, lighting, and so on. The Rendering tools and
materials libraries in ACA combined with the tools in SketchUp can produce awesome presentation renderings.
To use the library:
•
•
•

Select the File menu and select Send to Layout.
This will open Layout, a feature that is included with SketchUp Pro and is used for creating and sharing
presentations made from SketchUp.
You can add title blocks, save templates, add graphics, and create multi-page documents. Layout gives
you more control over color, style, and weight of the lines and faces in your SketchUp model.

End Note: SketchUp is an endless magic. You can make almost anything
An intelligent designer can use the SketchUp in various ways for the classic drawings. Nevertheless, we can tell
you that it is just some examples that we have brought to you. There are gigantic things to be discovered by the
enthusiastic designers. The world of SketchUp is next to endless. So, the crazy designers, now it is your turn to
spot those. Download the free version, try it and see how you like it. There is nothing better than going to a
meeting with awesome drawings that took only minutes to complete.
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3D modelling Design with Polymide material
A polyamide is a macromolecule with repeating units linked by amide bonds. They can occur both naturally and
artificially. Examples of naturally occurring polyamides are proteins, such as wool and silk. Polymide is
considered the best material for 3D modeling. In addition, it is not new to us that SketchUp is the best
programme for creating 3D Model. If designers want to create model they should know some basic learnings
with polymide 3D modelling.

Wall thickness: In 3D printing, wall thickness refers to the distance between one surface of your model and the
opposite sheer surface. Wall thickness can provide you either with a strong solid surface, or with a flexible and
expandable surface. A good example of creating thin surface walls is when designing a spiral that needs some
suspension properties. This makes your design light and flexible. The opposite effect can be achieved when
making your surface walls thicker. This would be ideal for a more solid spiral inspired flower vase.
Hollow out your model: Whenever it is possible, we advise you to hollow out your model. This avoids
deformation and discoloration during the printing process. You can either hollow out your model or keep the
polyamide powder trapped inside the model. Alternatively, you can design a strategically placed hole (two is
better) so the powder can be removed after printing.
Big flat plains can cause warping: Designing a big flat plain the size of an A4 page size is a bad idea. In most
cases, your model will deform. This process is called ‘warping’. Even creating support ribs under your plain
does not solve problem. On the contrary, it increases the chance of deformation even more. The key is to avoid
big flat plains.
The right space between your (moving) parts: When you want to design something like a pearl necklace or a
chainmail necklace, the spacing between your surfaces is crucial. It will determine the flexibility/bendability of
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your design. We advise you to keep a minimum space of 0.4mm between designed surfaces. However, the
more space you can afford the better. The more complex your design is, the more complicated it becomes for
the powder to exit the empty spaces. Try to think of how the powder will flow through the spaces of your 3D
printed design.
When you design something like chainmail, make sure you provide enough space between the rings in your 3D
model. It allows the powder between the rings to flow away when the model is taken out of the 3D printer. At
least, 0.4 mm of space should be kept between the rings, it can always be more. The space you create
between your rings will purely depend on their size. For big rings, you can create a lot of space so you can print
more of them in a confined space. For small rings, you will have to limit your space to keep a distance between
the opposite horizontal or vertical ring in the chain.
Using surface textures to hide building layers: Due to the building process of layered manufacturing, it often
creates a visible layer-based surface on your designs. To remove the visible building layers, models are often
polished. However, by applying a surface texture on your model, you can take advantage of the unsmooth
surfaces and get rid of the building layers on your surfaces.

Assembly
When designing models that need to be assembled, it is important to provide enough distance between the
parts that will be assembled. A perfect fit in your software package does not mean a perfect fit after printing
because your software ignores the friction present in the real world. Therefore, always leave at least 0.6 mm
distance between the different parts.

Embossed and engraved details
For engraved text or details in the surface, we recommend letters with a minimum line thickness of 0.8 mm and
a depth of 0.8 mm and an overall height of 3 mm or more. Embossed text or details on the surface should be
thick enough in order not to break during production and transport. We recommend letters that have a line
thickness of at least 0.8 mm, and an overall height of 3 mm or more. The depth should be at least 0.8 mm.

However, the designers have to concentrate more on polished models
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Our advice is for the designers to go beyond painting your model and discovers a special finishing option that
not only changes the way the model looks, but also how it feels. When adding a velvet finish to your models, a
suitable adhesive is applied to the surface. Then, fabric fiber is applied, penetrating the surface of the adhesive
to create the desired velvet finish.

Velvet
The process of adding a velvet finish to your models is called flocking and is done making use of an
electrostatic flock applicator. First, a suitable adhesive is applied to the surface. Then a metal pin is attached to
your model so it can be earthed. In a flocking machinethe "flock" is given a negative charge so that the flock
material flies vertically onto the substrate attaching to previously applied glue.Your model will always be marked
somewhere because of the need for the earthed pin to be inserted. So we advise you to foresee a hole of 1.6
mm in diameter with a minimal depth of 2 mm for pins at place where it isn’t visible as such (e.g. bottom).

Sharp corners and details
Since the velvet finish is added to your original design, you’ll notice that the details of your model will appear
less crisp.Due to the fact that we have to spray the adhesive on to the model, less accessible areas can’t be
sprayed on that well. This will cause your model to be less covered at those areas. Try to avoid the areas like
sharp corners or the insides of a model (e.g. a vase). Very thin parts are also more difficult to be cover due to
limited space where the flocks can be attached. Very thin details, articulated edges as well as thin wire frame
are very hard to cover.
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SketchUp: Layout Dimension Tool
SketchUp is a gift to a designer. A designer knows the importance of angular dimension and editing the same is
not too tough. A designer can edit the dimension string with SketchUp, length of the extension lines, and length
of the dimension line after you have created an angular dimension.

It is easy to edit a dimension using the Dimension Style dialog box. Designers need to follow certain
techniques. Some characteristics of the dimension can be edited by clicking on the dimension to select it and
clicking an option in the Dimension Style dialog box. The characteristics modified in the Dimension Style dialog
box are:
1. The dimension string's position relative to the dimension line.
2. The dimension string's position relative to the screen.
3. The units, scale, and precision represented by the dimension.
Refer to The Dimension Style dialog box for further information on Dimension Style dialog box options. The
Dimension Style dialog box is used to adjust dimensions-specific settings such as text alignment to the
dimensions line.
A designer can also modify individual dimension elements, such as the length of the extension lines or the
contents of the dimension string, after you have created a dimension. Following image shows an angular
dimension in Lay Out.
Editing individual dimension elements is possible here. An angular dimension is a group consisting three lines
and text string. The first line, called the starting witness line, extends away from the start point of the dimension.
The ending witness line extends away from the end point of the dimension. The dimension line is an arc
perpendicular to the start and end witness lines and represents the angle. The dimension text is tied to the
dimension line and displays the angle in degrees. Double-click on a dimension to access its individual
elements. Following is an image of an angular dimension after it has been double-clicked. Notice that there are
seven points on the dimension that can be manipulated: vertex, connection points, offset points, and extent
points.
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3D Printing: How it originated?
The 3D printing has its roots in the 1980s. In 1984, Chuck Hull, invented a process called ‘stereolithography’
which used UV lasers to solidify photopolymer that made 3D parts layer by layer. In 1985, Materialise CEO
Fried Vancraen was a young man making his own non-computer ‘FDM’ models. Five years later, he founded
Materialise, one of the first 3D printing companies.
Taking its roots in manufacturing, 3D printing was primarily used for prototyping products. In fact, large
corporations continue to use rapid prototyping to save millions of dollars. For example, Ford is currently using
3D printing to make large selections of its car parts for testing. According to Ford, the company can save up to
$493,000 a month of work with this production method. And now, we see that designers and individuals
worldwide are also turning to 3D Printing to bring their own creations to life, both for personal use and for the
enjoyment of others.

Additive manufacturing (AM) or 3D printing works a lot like your inkjet printer at home. The ink jet printer puts a
single layer of ink on top of the page in order to get the job done, while a 3D printer adds new layers on top of
each layer before it, until the object is completed. Because of this layer-by-layer printing process, an escape
hole is usually necessary to properly print and clean your models.
Since the 80s, many new materials for 3D printing have entered the market, including gold, silver, concrete, and
various other metals. Over the last year alone we have seen 3D printed houses, drones, dresses, jewelry and
table wear being printed. You might’ve heard about 3D printed prosthetics used to treat wounded soldiers too!
But, scientists are currently working on new, bigger projects. They are hard at work perfecting the next
generation of 3D printed materials. One day, we may even see 3D printed organs!
Traditional manufacturing models require a lot of upfront costs, storage fees and uncertainty from investors.
Machines have to be set up, space rented, and fingers crossed that the manufactured product sells. 3D printing
takes a more fluid approach: you can print orders on-demand. If you’re a maker or an entrepreneur trying to get
a small business off the ground, this can home in handy. The additive process wastes very little material and
you can print as the orders come in. This makes it less financially risky and translates into a low cost of
production.
3D printing is already being used in movies. Props can take hours of hard work to create and apply. With 3D
printing, many of those props can be created and re-created faster, easier, and without starting from scratch.
3D printing techniques have been featured in movies such as IronMan, The Hobbit, Jurassic Park, Avatar, The
Muppets, Terminator Salvation, Real Steel, Paranorman, The Avengers and Paranorman.
NASA researches are currently working on figuring out how to bring 3D printing technology to space. The idea
is to send robots ahead of astronauts to construct buildings and infrastructure on lunar surfaces. 3D printing is a
growing training area in schools, and is also being used to integrate students with disabilities in programs that
has traditionally excluded them (and often still does.) Personalized, 3d printed medical solutions can empower a
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person with arm injuries to become a musician, a person without legs to play soccer, and students who are
blind to “see” microscope slides.
For younger students, art, design, entrepreneurship and engineering are unlocked with increasingly simple 3D
modeling tools. These tools empower children to turn their ideas into objects they can hold. The first community
college in Texas is now offering 3D printing classes this fall and educational programs are available for those
wanting to introduce the biomedical applications of this technology into their curriculums.
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Theory of 3D modeling
In 3D computer graphics, 3D modeling is the process of developing a mathematical representation of any threedimensional surface of object (either inanimate or living) via specialized software. The product is called 3D
model.
It can be displayed as a two-dimensional image through a process called 3D rendering or used in a computer
simulation of physical phenomena. The model can also be physically created using 3D printing devices.
The new comers could also know that the 3D modeling software is a class of 3D computer graphics software
used to produce 3D models. Individual programs of this class are called modeling applications or modelers.
SketchUp (Formerly: Google Sketchup) is a 3D modeling program for applications such as architectural, interior
design, civil and mechanical engineering, film, and video game design. A freeware version, SketchUp Make,
and a paid version with additional functionality, SketchUp Pro, are available.

There are many 3D modeling software. Some are freeware and others are commercial that means paid. Among
them also some are 3d rendering, but other is not.
Almost all 3D models can be divided into two categories: Solid - These models define the volume of the object they represent (like a rock). These are more realistic, but
more difficult to build. Solid models are mostly used for no visual simulations such as medical and engineering
simulations, for CAD and specialized visual applications such as ray tracing and constructive solid geometry
Shell/boundary - these models represent the surface, e.g. the boundary of the object, not its volume (like an
infinitesimally thin eggshell). These are easier to work with than solid models. Almost all visual models used in
games and film are shell models.
There are three popular ways to represent a model:-
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Polygonal modeling - Points in 3D space, called vertices, are connected by line segments to form a polygonal
mesh. The vast majority of 3D models today are built as textured polygonal models, because they are flexible
and because computers can render them so quickly. However, polygons are planar and can only approximate
curved surfaces using many polygons.
Curve modeling - Surfaces are defined by curves, which are influenced by weighted control points. The curve
follows (but does not necessarily interpolate) the points. Increasing the weight for a point will pull the curve
closer to that point. Curve types include nonuniform rational B-spline (NURBS), splines, patches and geometric
primitives
Digital sculpting - Still a fairly new method of modeling, 3D sculpting has become very popular in the few
years it has been around.[citation needed] There are currently 3 types of digital sculpting: Displacement, which
is the most widely used among applications at this moment, volumetric and dynamic tessellation. Displacement
uses a dense model (often generated by Subdivision surfaces of a polygon control mesh) and stores new
locations for the vertex positions through use of a 32bit image map that stores the adjusted locations.
Volumetric which is based loosely on Voxels has similar capabilities as displacement but does not suffer from
polygon stretching when there are not enough polygons in a region to achieve a deformation. Dynamic
tesselation is similar to Voxel but divides the surface using triangulation to maintain a smooth surface and allow
finer details. These methods allow for very artistic exploration as the model will have a new topology created
over it once the models form and possibly details have been sculpted. The new mesh will usually have the
original high resolution mesh information transferred into displacement data or normal map data if for a game
engine.

The market of 3D modelling
A large market for 3D models (as well as 3D-related content, such as textures, scripts, etc.) still exists - either
for individual models or large collections. Online marketplaces for 3D content, such as TurboSquid,
The3DStudio, CreativeCrash, CGTrader, FlatPyramid, NoneCG, CGPeopleNetwork and DAZ 3D, allow
individual artists to sell content that they have created. Often, the artists' goal is to get additional value out of
assets they have previously created for projects. By doing so, artists can earn more money out of their old
content, and companies can save money by buying pre-made models instead of paying an employee to create
one from scratch.

3D printing is one of the important aspects to learn for the new comers
The 3 Dimensional Printing (3D Printing) is a process for making a physical object from a three-dimensional
digital model, typically by laying down many successive thin layers of a material. It is often called additive
manufacturing (AM), reasons the additive nature of process in which successive layers of material are laid
down under the computer control. A 3D printer is a type of industrial robot. Now a day, 3D printing with
SketchUp is more than just prototyping. It offers transformative advantages at every phase of creation, from
initial concept design to production of final products and all steps in between. Today's competitive environment
makes choosing the right 3D printers more important than ever.
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Human model
The first widely available commercial application of human virtual models appeared in 1998 on the Lands' End
web site. The human virtual models were created by the company My Virtual Mode Inc. and enabled users to
create a model of themselves and try on 3D clothing.[7] There are several modern programs that allow for the
creation of virtual human models.

Uses of 3D model
3D modelling is used in various industries like films, animation and gaming, interior designing and architecture.
They are also used in the medical industry for the interactive representations of anatomy. A wide number of 3D
software is also used in constructing digital representation of mechanical models or parts before they are
actually manufactured. CAD/CAM related software are used in such fields, and with these software, not only
can you construct the parts, but also assemble them, and observe their functionality. The 3D modelling is also
used in the field of Industrial Design, wherein products are 3D modeled before representing them to the clients.
In Media and Event industries, 3D modelling is used in Stage/Set Design.
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Europe, US look to bring 3D printer in school for children
Once it was the personal computer which brought wonder to the classes of the school. But now the time has
changed. It is now turn to install 3D printer in school. As time went on, this technology moved into the
curriculums of schools worldwide. Education leaders decided that computers would be used extensively in our
future, and those teaching kids the basics of this technology early on, would be of utmost importance. I’m
thankful for the education I got in personal computer use, as it has driven my career, and opened up
opportunities in my life. Now a couple of decades later, history is repeating itself in the form of 3D printing in US
and UK.
Only within the past year or so, has 3D printing begun to arrive in elementary, middle and high schools
throughout the world. Just like how my computer skills are head and shoulders above that of most individuals
from my parents’ generation, due to the fact that I was taught basic computer concepts in school, one day my
kids will undoubtedly have skills in 3D modeling, 3D scanning and 3D printing that I probably won’t even be able
to grasp. It takes initiative though, in order to get federal, state, and local governments to work together to
incorporate new, relatively unknown technology into a school’s curriculum.
One 3D printer manufacturer, some companies are attempting to start this initiative. Through a program that
they refer to as “3D in Schools”, they had set out to bring 3D printing technology to every school in Portugal.
Now the second step of the project is to spread this idea to other countries, so that more children have access
to what could quite easily be just as revolutionary as the personal computer.
To put this initiative into gear, they have outlined a three-step solution, which is as follows:
1. Widespread provision of specific technological solutions to schools;
2. Adaptation of teaching content;
3. Presentation of advantageous commercial solutions.

25 | P a g e

At this juncture, those organizations are selecting potential partners who can help them along the way. They are
looking for help from organizations within the education and technology sectors, as well as those who are
suppliers of school equipment, and ask that anyone interested in helping out.
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Modifying 3D Shapes in SketchUp Using the Scale Tool
In this tutorial, I want to talk a little bit about using the scale tool to work with three dimensional objects. First, let’s take a
second and review where the scale tool is located. Look up at the top of your screen for a little icon that looks like a brown
box inside a red box with a red arrow coming out of the corner. This is the scale tool.

Let’s start off by drawing a box, then extruding it into a cube. You can draw the box using the rectangle tool, and then use
the push-pull tool to extrude it into a 3d shape. Once you’ve done that, you should have a shape like the following image
below.

I want to start off by talking about how you select your object when working with 3D shapes. When we were working with
two dimensional shapes, it didn’t really matter how you selected your object because you were only dealing with a single
face. However, with a 3D object, this isn’t the case anymore. You can select any of the individual faces on your cube and
scale them without scaling your entire cube. This is useful, but it can also deform your shape, so you have to be careful.
Let’s start by selecting our entire cube. Select the whole cube by dragging a select box all the way around it. If you’ve done
this correctly, all the bounding edges and faces in your model should be shaded blue, like the image below.
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Now, just like with our two dimensional objects, we’re going to activate the scale tool by clicking on the scale tool icon above
or just pressing the “s” key on your keyboard. When you do this, you’ll notice a bunch of little green boxes show up on your
cube. These are the “scaling grips.”

These grips work exactly like the ones we talked about in the two dimensional scaling tutorial previously. You can click and
drag any of these grips to resize your object.

Like with our 2d objects, if you want to scale them uniformly, it’s best to use the corner grips. However, if you want to scale
your object along only one axis instead of scaling your whole object, you can use the other edge grips. For example, if I
wanted to keep my box the same length and width, but I wanted it to be shorter, I’d select the edge grip in the middle of the
top face of my box.

While this would make my box shorter, I would only be changing my object along one axis while keeping the other two axes
the same, meaning that my object’s proportions would be different.
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The scaling grips work exactly the same way they did with the two dimensional objects, meaning if you want to scale your
object precisely, you can click once on your scaling grip, then type in a decimal value and hit the enter key on your
keyboard. This will scale your object based on the value you entered. A value of .5 would make your object half the size it
was before. A value of 2 would double the size of your object.

This is especially useful when dealing with objects that you download from the 3D warehouse, because a lot of those
objects are not drawn to scale, so they need to be resized either bigger or smaller to fit in your model. For example, I did a
quick model of the room that I’m sitting in now, using objects from the 3D warehouse to furnish the room. As you can see
from the image below, the desk that I selected is far too large for the room I’ve drawn.

It’s taking up an entire wall, and it’s taller than the windows in the room. What I’d do to make it fit is click on it once to select
it, then activate the scale tool and click on one of the corner grips (because the corner grips scale your model while retaining
its proportions). I’d drag the corner grip until my desk is resized properly and it looks like it fits in the room.
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Also note that if you want to scale an object while retaining its proportions, but you don’t want to use the corner grips, you
can also use a modifier called “uniform scaling.” To use the uniform scaling option of the scale tool, simply hold down the
shift key while resizing your object with the edge grips. This allows you to scale your object using any of the edge grips while
still retaining your object’s proportions.

Now we’ve talked a lot about using the scale tool to resize a complete object, but the scale tool can also be used to resize
parts of objects in order to adjust shapes. For example, let’s draw a cylinder by drawing a circle with the circle tool, then
extruding it with the push pull tool. This will give us an object that looks like the image below.
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Now, select the top face of the object by clicking on it. Once you’ve selected your top face, activate the scale tool using the
“s” key. You’ll notice that you get scaling grips only around the top of your cylinder.

This is because you’re only going to scale this one face. Click and drag one of the edge grips. As you can see, the size of
your top face changes, and SketchUp resizes the rest of your model accordingly.
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However, let’s say you wanted to make this entire face larger in all directions at once, instead of just one, so you can retain
symmetry in your model. To do this, you would use the “About Center” modifier. This modifier works the same way in 3D
objects as it does in 2D objects. What you would do is select your top face, activate the scale tool, and select one of the
corner grips. Once you’ve selected one of your corner grips, hold down the “Control” key on your keyboard. What this does
is force SketchUp to scale your top face around the center of the face you have selected, instead of about a fixed point on
the opposite side of your face.

As we discussed in the two dimensional scaling tutorial, SketchUp does not come with a dedicated mirroring tool (it does
contain a tool that allows you to flip your objects about an axis). If you want to mirror an object (flipping it so it maintains
proportions), the scale tool has this functionality. Let’s use the cone we created above as an example. I’d like to flip this
cone over so the wider face is facing down, instead of up. There are two ways to do this. The first way is to select your
object, activate the scale tool using the “s” key, and click on one of your edge grips. Then type a value of “-1” on your
keyboard and hit enter. This will mirror your object about the opposite edge grip from the one you selected.
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This is an good way to mirror objects in SketchUp. However, sometimes, you want to mirror 3D objects in place instead of
moving them with the scale option. To do this, we’re going to use the “About Center” modifier to the scale tool. Here’s a
great example – sometimes in SketchUp, you want to copy and mirror components when working with symmetrical objects,
because then you only have to spend time modeling half of your object, and the other half will automatically update with
your changes. Let’s say you have a 3D shape like the one below.
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I’ve made it into a component, and I’m going to create a copy using the move tool.

Now if I used the method discussed above to mirror this object, I’d have to mirror my object, then move it so the sides are
aligned the way I want them. Since I already have my object where I want it, I’m just going to mirror it in place using the
“about center” modifier of the scale tool.
Before I do that, I want to mention one of the great things about the scale tool. If you go ahead and select the copy of the
object that you just created, then activate the scale tool, you can see that your scaling grips are blocked by your first object.
However, if you place your cursor in the area where your grips should be, SketchUp will show you your grip, even if it is
behind another object.
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Now let’s mirror our object in place. To do this, we’re going to select the edge grip that was hidden by the other object. Click
on it, then hold down the control key on your keyboard to activating scaling about center. Now move your mouse across the
object until the value in the measurement bar below reads “-1.”

This will mirror your object while keeping it in the same location. The nice thing about this is as long as we are modeling an
object that is symmetrical (the same on both sides across an axis), all we have to do is make changes to one half of our
model and the other half will change as well.

As you can see, the scale tool is a very powerful, useful tool that can really help you harness the full power of SketchUp. If
you can incorporate it into your modeling workflow, it can save you a lot of time and effort.
http://www.thesketchupessentials.com/author/justin/
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Doing Much more with SketchUp Components
If you have any practical experience of SketchUp, you've probably already used components. But if you're like
most users, you have only scratched their true potential. Do you wonder what it is?
Well! With SketchUp components, you can...

Dissociate parts of a model
Like groups, SketchUp components are used to separate a selection of entities from the rest of the model. This
way, it's then possible to select a set of entities with one click and manipulate it with a tool like the Move tool or
the Rotate tool.
This is the only solution to avoid that lines and faces, even if they are on different layers, intersect and stick with
each other.

Manage the display of parts of the model with layers
As stated above, layers do not allow a selection of lines and/or faces to separate from the rest of the model.
The components are, along with the groups, images, texts and dimensions, the only entities to be placed in
other layers as the default layer (Layer0). You can control the display of entire entities 'families' by placing
groups and components representing similar objects into individual layers that you can switch on and off with
one click. For example, you can place all the furniture into one layer, all the vegetation in another and so on.
You can also switch on or off a selection of layers by creating Scenes (but that's another story).

Easily edit part of the model
By hiding the rest of the model while editing a component, you are working on a part of the model without being
bothered by the rest. For example, you can work on the interior of the first floor of a building without the floors
above masking it. It is also possible to hide similar components if necessary.
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To hide the rest of the model while editing a component (or a group), click on the View drop-down menu
> Component Edit > Hide Rest of Model.

To hide similar components (copies of a component), click on View > Component Edit > Hide similar
components.

Move AND Rotate quickly with one tool
By moving the Move tool over a component (or group), you see little red crosses on the sides of the bounding
box. By moving the cursor over one of these crosses, you can rotate the object around the central axis of the
bounding box. Useful to quickly design a space by moving and rotating items of furniture or decoration with a
single tool !

Create similar copies
Unlike copies of groups or selections of entites, all copies of a component are changed at once when you edit
one of the copies. But don't worry: it is always possible to separate one or more copies of a component of other
similar components by making them unique.
To make a copy or a selection of copies of a component unique, right-click on the selection and choose Make
unique in the context menu.
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Symmetrical modeling
A mirrored copy of a component model that allows you to model only half of a symmetrical object. Radially
symmetrical objects can also be divided into identical slices that all radiate from a central axis. All changes to
one of the components will be automatically reflected on the mirrored part(s).

Create and use collections of components
Unlike groups, the components may be stored outside of the model, in collections of components. These
components are then reused in other models. The most famous collection is the 3D Warehouse of SketchUp,
accessible from the web. But the ideal is to create your own collections of optimized components (insertion
point, denomination, removing unnecessary elements, the component level, etc.) or from downloaded
components either from your own.
You can import a component either from the Components Browser dialog box or fromImport drop down menu
(with SketchUp SKP File type selected).
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Simulate a complex three-dimensional object with a 2D image
You can also create a « Face me » components, 2D components facing the camera to simulate a 3D object.
This is the case of the character of Susan that automatically appears when you open a standard models in
SketchUp. It is thus possible to use a photograph for simulating a complex 3D object as a tree or a person.
Composed of far fewer faces and edges, the display of these 2D elements is generally much faster than their
equivalents modeled in 3D.

Easily place a selection on any face on any plane
By setting an alignment option when you create a component, the component automatically orients itself (and
"glue") on the clicked face when inserted from the Components dialog box. You can choose among the options
Any, Vertical, Horizontal or Sloped to glue the component to a face.
You can choose the orientation of the component by clicking on the Set Glue plane button to change the default
position and orientation of the axes of the component.
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Create and switch between alternative designs
Each alternative is contained in a component that can be saved outside the model. You can then replace it with
another variant. This way, you can replace, in just a few seconds, the top floor of a building or the thousands of
seats of a football stadium.

Pay attention though ! To be able to replace a component by another, both components should have their axes
positionned and oriented accordingly. For example, to replace a chair by another, you should place the origin of
the axes on the ground, on the center of the chair, with the back consistently oriented along the same axis (I
chose the green axis).

Use the Solid tools
Solids tools to perform Boolean operations (union, intersection, subtraction of volumes, etc.) only work with
solid groups or components. Warning: the new object obtained from the use of a Solid tool is always a group.
So there is no real advantage to create component in this case except you can immediately give it a name that
make sense at the creation (see next paragraph).
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Effective management of SketchUp model
The components being named at the time of their creation, they can be easily sorted and selected from
the Outliner dialog box ... As long as you give them a name that has meaning ! Keeping the default name given
by SketchUp (Component # 1) has no benefit.
It is also easier to hide and reveal from this Outliner dialog box.
Also, by nesting components and groups, ie by creating "parent" component containing other "children"
components or groups, you can organize the different parts of a complex model.

Dynamic components
From simpler, with just custom attributes (for example indicating a brand, a model, a price, etc.) to more
complex dynamic components that can be changed and/or moved parametrically.

Dynamic components can be used by the free version but you need SketchUp Pro to create them.
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Quantify
The Entity Info dialog box display the volume of a solid group or component. You can use the tool Generate
Report (SketchUp Pro) to extract data from custom attributes and other information from a selection of
components or from the whole model.

Use with some SketchUp plugins
Many plugins or extensions that boost the capabilities of SketchUp will only work with components or groups.

What a huge range of possibilities !... To try the SketchUp component is to love it! I am absolutely convinced
that the SketchUp components will save you much time.
NB: If you want to take full advantage of SketchUp components and create your own collections of quality
components, do not miss my article How to optimize SketchUp components imported from the 3D
Warehouse !
www.arch-image.com
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How to optimize a component imported from the 3D Warehouse of
SketchUp
Laurent Brixius
In my article Doing MUCH MORE with SketchUp components, I introduced you to the various(and numerous)
uses of the components in SketchUp. And I am pretty sure this article has convinced you of their interest.
But their clear benefits can be greatly reduced when these components are poorly designed, which is more the
rule rather than the exception in SketchUp's 3D Warehouse.
Fortunately, it is possible to fix and optimize existing components to make them quickly and easily reusable for
your projects. Here's the description of the steps to optimize a correctly modeled SketchUp component :
NB : Do it yourself by searching for « tuto chaise » in the 3d Warehouse and import the component I use in
SketchUp training. Select the component « TUTO Chaise à optimiser 2.0 ».

1 Remove unnecessary entities
A component is often cluttered with useless elements. This can be edges, faces, guides, images, or other
components or groups. Be sure to display all the entities of the component ! Remember to make all layers
visible and display hidden geometry from the View drop down menu.
On the chair you just downloaded, you will instantly notice Susan but, when displaying hidden entities, you will
also find a hidden guide and a hidden box. Now open the Layers dialog box and check both Google Earth
Snapshot and Google Earth Terrain visible. Now delete all the entities that are not part of the chair.

2 Place the insertion point consistently (and intelligently)
For a chair, it will be on the ground plane, centered in the middle of the seat. This way, you can replace the seat
component with another one larger (or shorter) or higher (or smaller) seat with the Reload command.
To find the correct axis origin for this chair, draw a diagonal line from two opposite chair legs. Next, select all
the chair entities and move it with the Move tool from the Midpoint of the diagonal line to the Origin of the
axes. Delete the diagonal line.
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3 Orient the axes of all your components in a homogeneous way.
By orienting all your components homogeneously, you will be able to replace a component by another using the
Reload command without having to rotate all copies of the component in your model afterwards.
For example, I chose to always orient the back of the chairs and seats to the green positive axis. For now, the
chair's back is oriented to the negative red axis. Select all the chair's entities and use the Rotate tool, using the
origin of the axes as center point, to rotate the back to the green positive axis.
NB : To replace a component, rightclick on the component you want to replace, click on Reload in the context
menu and browse your hard disk to select another (optimized) SKP file. Click Open to validate the change.

4 Check the scale
If necessary, adjust the scale of the content of the component using the Tape Measure tool. For this, doubleclick on the component to edit the component and measure an item that you know the correct length, for
example the seat height of a chair. The actual measured value is displayed in the Measurements area. Then
type in the correct measurement, press Enterand confirm when SketchUp asks if you want to resize the active
group or component.
NB : Another benefit of using the Tape Measure tool is that scaling occur from the origin of axes wich is not the
case with the Scale tool. The Tape Measure tool is also much more accurate. The chair is more than ten times
too big. To correct its scale, measure its seat height (430cm) ant type 42,5cm then validate the change.
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5 Delete layers other than Layer0
This step is not absolutely necessary, but if you insert a component that's having parts in otherlayers, these
layers will also be inserted into your model, which is not always desirable.
The chair component has 3 unnecessary layers : Bois, Google Earth Snapshot and Google Earth Terrain. You
can select them and click on the Delete layer icon (« minus » icon). Keep the default option to move entities on
the deleted layer to the default layer Layer0 because most entities of the chair are in the Bois layer.

6 Use a consistent naming convention for your components
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It is very interesting to give your components meaningful names. This way, you can easily select and even filter
components from the Outliner dialog box.
I personally use a Belgian classification system (or more exactly a part of) name BB/SfB developped by the
Régie des bâtiments, a public service that manage most of the Belgian federal real estate.
The best part of this classification, for me, is the use of two digits to identify an architecture element. For
example, exterior walls begins with 21, interior walls with 22, floors with 23, and so on. Add 10 and you get the
secondary parts like 31 for exterior windows, 32 for interior doors and so on. With 10 more you got the
finishing... All architecture parts have their coding, from the earth to the furniture. With those two digits, all parts
are automatically sorted and you can easily find and select a component or a named group in
the Outliner dialog box. It's a huge time saver.
If needed, close the edited component and select it. In the Entity info dialog box, give it a meaningful name.
Following my classification, I would name it 82chairDesignerModel where 82 is for mobile furniture and where I
would replace Designer by the name of the designer or the manufacturer and Model by the name of the model
or a serial number.

7 Remove geographic coordinates
It may (hopefully seldom) happen that the component is georeferenced, that is to say, it has geographical
coordinates of longitude and latitude. In this case, when it is inserted into your model, you can not determine its
insertion point, it is automatically placed at the origin of the axes.
To remove those geographical coordinates, you must first save it into a collection, that is to say in a folder on
your hard drive or network. Then open the SKP file that you just saved. Then click on the drop down menu File
> Geoposition > Clear location. And save your model!
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8 Check the texture resolution
If the component contains textures, make sure they are not too high resolution. In SketchUp, it is generally
unnecessary (and unproductive) to use images in high resolution as textures. In most cases, an image that do
not exceed 512 to 1024 pixels wide will be amply sufficient.
Similarly, to reduce the size of the SKP file, choose the JPEG format (not too compressed to avoid compression
artifacts) to one of the other available formats. If your image has an alpha transparency layer, use the PNG
format, which is also a great choice if your image has few different colors (like a drawing in black and white).
Your component is now ready to be used easily in other SketchUp models. Enjoy !
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Create glue-less interlocking laser cut parts with sketchup slicemodeler
Andrew Jones

With the use Google sketchup and the slicemodler plugin its possible to create laser cut 3D shapes that snap together
without
glue.
What you need:

•
•
•
•
•

Google stetchup
slice modeler plugin
sketchup svg export plugin
A laser cutter or laser cutting service like http://www.ponoko.com/
A SVG editor like inksacpe http://www.inkscape.org/

Step 1: Install sketchup and Plugins
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Download and install sketchup, then download the svg export plugin and the slice modeller plugin.
Start sketchup. I use the "Product Design and Woodworking - Millimetres template"
Install the slice modeler and svg export plugins in google sketchup: Window > Preferences > Install Extension. Navigate and
select the rbz plugin files.

Step 2: Experiment with different size nodes
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The glue-less design is achieved by placing small curved bumps (nodes) in each slot. The curve of the bumps allow the
parts to slide together but provide enough pressure on the material to fit together snugly. There are multiple factors that will
influence the size and number of the nodes, including slot length wood thickness and wood density.
I highly recommend creating parts with different size and numbers of nodes so you can find the best fit that works for you.
You might want a very hard fit that needs to be tapped together with a rubber mallet or you might want a fit that can be
assembled by hand without any tools. The only way to find the fit that works for you is try different size nodes. See this
article for more about nodes.
What worked for me:
My trivets are made out of 4mm Italian poplar Plywood and I found that a single node 5mm wide and having a 0.16mm
bulge made a good fit, that could be snapped together by hand. However different materials will need different node sizes
and you need to figure out what works for you.
Next we'll create a test object in sketchup to test how various size nodes work with your chosen material.
Download SVG

Step 3: Create a test object in sketchup
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My test object is 2cm high and 7cm wide and 7cm long. Using a square test object shape means all the slices will be the
exactly the same. A test object of these dimensions should be enough to gauge how well the different size nodes work. The
height is the most important factor to get right. So make sure you create a test object with the same height as your end goal
design.
Open sketchup and create a square 7cm by 7cm and extrude it 2cm up.
Now its time to slice it up. Select the object and convert it to component by selecting all (ctrl-A) right clicking on the object
and select "make component". Leave the component name as the default one.
IMPORTANT sliceModeler changes the model it's slicing so make sure to make a copy of it. To do this select the model and
copy and paste a copy (ctrl-c ctrl-v).
To slice the model select the component and open the sliceModeler dialogue (plugins -> sliceModeler). In the sliceModeler
dialogue set:

•
•
•
•

slice spacing of 20mm
slice thickness to the thickness of your material, in my case the Italian poplar is 4mm thick.
slice orientation to X
Leave other settings as the default.
Click ok and say yes to "adding a number to each slice" and yes to leave the original hidden. For the Y orientation dialogue
leave everything as default and click yes to "leaving the original section hidden". Click yes to "make flatten copies", leave
minimum gap as default. You now have flattened slices and an "assembled" model to work with. Next step we'll add the
nodes to a slice.

Step 4: Adding the nodes to a slice
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It time to add the nodes to a slice. I find it easiest to work in a new sketchup file. Since this model is square all slices are the
same so you only need to copy 1 slice. SliceModeler exports the 4 slices as 2 groups. To copy a single slice double click on
the group to edit the group and click on a single slice. Double check the whole slice is selected and copy it (ctrl-c). Open a
new sketchup window (ctrl-n) and paste your slice in (ctrl-v).
Zoom into your slice and select the top down view. Your slice should be positioned as per the image above.
The node we will create will be 5mm long and have a bulge height of 0.16mm. Click on the tape measure tool and drag a
guide from the left edge of the slice and set it's distance to 2.5mm. Now create another guide and set it's distance to 7.5mm.
Using these guides will ensure the node length is 5mm. Next we'll create the node bulge.
Zoom right into one of the interlocking slots in the slice and use the orbit tool to view the gap at an isometric angle as
pictured above. Select the arc tool and create an arc between the two guides as pictured. Make sure the arc is orientated
along the green axis. The line in the arc will change green to indicate you are on the right axes. Set the bulge height to
0.16mm. IMPORTANT to create a continuous outline vector for the laser cutter you need to delete the line behind the arc as
pictured. Now repeat the arc for the other side of the slot and the same again for the 2nd slot.
You will now have a slice surface with 2 slots and 4 nodes that can be exported to an svg.

Step 5: Exporting the slot into inkscape
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To export the slice svg out of sketchup select the top down view and select none (ctrl-T) then select the surface you just
created the nodes on (it will be the top surface). The selected surface will be covered with small dots. Now export the svg by
clicking on the flight of idea SVG icon. Deselect "export annotations for faces" leave everything else as default, enter a
filename and click ok. Open the file in inkscape and you will see the outline of the slice as per the screen shot.

Step 6: Adding the svg to a laser cutting template

I use ponoko's laser cutting service to cut my test slices. If you use a different laser cutting service follow their instructions.
For the rest of this step I'll be talking about ponoko's inkscape template. Download ponoko's inkscape template from here. I
used the p1 18x18cm size template. Open the exported slice svg in inkscape, select all (ctrl-A) and copy (ctrl-C). Open the
ponoko inkscape template and paste the slice (ctrl-v). Because the test object is square you can simply paste in three more
slices so you have a total of 4. Arrange the four slices into a rough 2x2 grid. You want the slices all nicely spaced and
aligned so its less movement for the laser. Open inkscape's align and distribute dialogue (shift-ctrl-A) select the left 2 slices
and click center on vertical axis do the same for the right 2 slices. Do a similar thing but horizontally. The end result is 4
nicely aligned slices as per the screenshot.
Ponoko is very specific about the template's cutting line color and stroke width. For cutting lines the line color must be solid
blue and have a stroke weight of 0.1mm. To set the correct color and stroke weight, open the fill and stroke dialogue, select
all (ctrl-A) and double check the stroke paint is R:0 G:0 B:255 A:255 and in the stroke style tab set the width to 0.01mm. The
cutting lines in the template should be barley visible. Before uploading the template to ponoko do a sanity check of the
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cutting vectors. The easiest way to do this is select outline display mode (view -> display mode -> outline) and zoom right
into each vector and make sure there are no gaps that will result in an unclean cut.
Your done! Your now ready to upload the template to ponoko for cutting! However I see much more space in the template
for slices with different node sizes. In the next step I'll discuss experimenting with different node sizes.

Step 7: Expermenting with different node sizes

The ponoko template has enough room for 16 slices, so in a single cutting order you can create 4 test objects each with
different node sizes. In the pictured file I create 4 test objects with the following node configurations:
1.
2.
3.
4.

single node with bulge height of 0.4mm
single node with bulge height of 0.2mm
double nodes with bulge height of 0.4mm*
double nodes with bulge height of 0.2mm*

(A double node is where you have 2 smaller nodes in a slot, this gives better stability then a single node but its harder to
assemble).
With the 4mm Italian poplar I found the 0.4mm single node too hard to assemble by hand. I also found the two double node
test objects too hard to assemble.
I did find the 0.2mm possible to assemble by hand but it was a touch harder then I'd like, so I dropped the node bulge to
0.16mm. And when I received my next ponoko order the 0.16mm bulge height was quite easy to assemble by hand. It also
provided firm interlocking parts that "click" together. Now back to your test object(s).
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Download SVG

Step 8: Assembling the test objects

Once you have received your order from ponoko your now ready to assemble the test objects. But first write on each slice
which node configuration it is, as its easy to forget. Now attempt to assemble each test object while taking notes on how
hard or easy it is to assemble. If you find the right balance between ease of assembly and "fit" then your done. Otherwise if
none work, take note if the fit is too loose or tight and repeat the process.
Congratulations! You can now make awesome interlocking laser cut products that can be hand assembled and don't require
any glue!
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Nike introduced 3D Printed footwear for NFL
Nike’s 3D printed footwear surges through the popularity among the crazy US youths. Founded in 1964, Oregon based
Nike, Inc. has made an impression among its users across the world with the products. As most of us already know the
company’s intension to create a global product in the likes of 3D printed shoes, the brand new Vapor Carbon 2014 Elite
Cleat has already been introduced in this year’s Super Bowl.

The formation of this elite cleat took almost two decades of research and insight to bring out the best performance. The
game of football is mixed with speed, power and acceleration -- Vapor Carbon 2014 Elite Cleat considered to be best fit in
the game. This cleat featured a 3D printed nylon based plate that Nike called the V-Plate.
But this seems to be a beginning only. The company is using 3D printing in a big way to bring a revolution in the shoe
designing and prototyping, particularly cleat. There are some more to come. The new Nike Vapor Laser Talon concept cleat,
which has been made, uses 3D printing technology.
Nike, Inc. appears to be extremely serious in promoting this footwear made of using 3D printing techniques. The signal
indicates that the majority of the shoes would be 3D printed in days to come.
The advancement of technology will speed up the printing process and make it more accurate by the time. It will be an
economically viable path to reach, especially if they are able to lock up key patents within the industry, like they have begun
doing.
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The brains behind Vapor Carbon 2014 Elite Cleat are director of innovation Shane Kohatsu and designer Ken Link
commend their product, but the endorsement came from Olympic legend sprinter Michel Johnson. Johnson, owner of MJP
training centre, a Nike athlete lauded the 3D printed product. He was joined by Lance Walker, director of performance, MJP
training centre and NFL start athlete Marqise Goodwin.
The method that have used here is designing a three-dimensional pattern for printing, positioning at least a portion of the
article on a tray in a three-dimensional printing system, the portion being positioned substantially flat on the tray, printing a
three-dimensional material directly onto the article using the designed pattern, curing the printed material, and removing the
article from the three-dimensional printing system.
There are many more exciting apparel products to come in future on behalf of the company.
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A wonder! 3D Printed Estate is coming soon in NY
Imagine a residential estate which features a 3D printed swimming pool, 4-bedroom, 2400 square foot home,
and more. The 3D printer which will be a modified version of Enrico Dini’s D-shape printer, will, if all goes as
planned, eventually be able to automatically place rebar within the 3D printed house, as it prints. US based
architects and contractors have started this venture in Gardiner, New York. Earlier the country has experienced
the 3D printed castle and salt house. But this venture by architect Adam Kushner is expected to be popular by
people’s choice. The three men to be given credit in this matter are Adam Kushner, James Wolff, and Enrico
Dini.

In a recent interview with 3DPrint.com Kushner said: about a year and a half ago, he started to become
immersed in 3D printing. “I said, OK, who’s doing this on the construction level?’ That is where I see the future. I
don’t care about the toys or the games or the little things people are doing on their desktops. What I really saw,
was the bigger potential for 3D printers in the construction industry. That is a trillion dollar business, and it
changes the paradigm of how we build.”
Adam Kushner and partners James Wolff, and Enrico Dini have planned and already have begun to undertake
in Gardiner, New York. Kushner, who runs KUSHNER Studios and In House Group in New York City, has over
25 years of experience in the construction industry. His company has designed and constructed buildings in
Manhattan as large as 80,000 square feet in size, and he, as well as his company, has been featured on shows
such as Fox News, BBC Home, and Celebrity House Hunting.
Kushner found a man named Enrico Dini, who is quite well known in his own right, for the invention of his
extremely large 3D printer, capable of printing out large structures and buildings. Dini owns and operates a
company called D-Shape, as well as a patent for a magnesium-based binding process that the 3D printer uses.
The process combines sand or other materials with a magnesium-based binder to create stone-like objects.
Kushner told Dini that he wanted to bring his 3D printers, and the process in which they print with, to America,
in hopes of using them for a few truly unique construction projects. Dini informed Kushner that he had been
talking with a man named James Wolff about opening a potential business for D-Shape in America. Kushner
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contacted Wolff, the two hit it off, and to make a long story short, they decided to create D-Shape Enterprises
New York. Wolff is the co-founder of Deep Space Industries, which won two major NASA contracts for the
asteroid mission and now has an office at Ames. Just this past June, Kushner flew over to Italy to meet with
Dini. The two agreed to ship one of these large 3D printers back to New York, and it is scheduled to arrive in
January of 2015. From there, Kushner, Wolff and their team of workers plan to begin 3D printing what will
undoubtedly be the single most amazing 3D printing project ever undertaken. Surprisingly, Kushner has no
doubts that he will successfully accomplish it.

The massive project that KUSHNER Studios will be undertaking is for the 3D printing of an entire estate in
Gardiner, New York. It will feature an in-ground swimming pool, a pool house, and a 2400 square foot, 4
bedroom home. If accomplished, like Kushner undoubtedly believes, it will go down in history as perhaps the
most innovative project that brought 3D printing into mainstream construction – which if successful it
undoubtedly will do.
The 3D printing of the 2400 square foot house, which Kushner hopes to start in about 14 months from now, will
be the most challenging. He sees this stage as where most of the major breakthroughs in the 3D printing
technology will take place. Up until now, with previous ’3D printed house’ projects, we have only seen very
small houses actually 3D printed, or in some cases, small sections which have been assembled together.
Kushner plans on blowing away all of these projects by completely 3D printing a full-size home. To do so, he
plans on using ideas that have only previously been dreamt of, or in some cases unimagined altogether.
“It could be ego driven, it could be legacy driven, but if I am going to leave the world anything, I’m hoping that
perhaps this might be my little niche,” Kushner added.
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FabCafe Mini 4WD Cup: Team Honda took the 3D Printed trophy
The Japanese engineering spirit is great. Around 60 mini 4WD fans including children and professional car designers
assembled Kashiwanoha KOIL to race their miniature cars customized by 3D printers and laser cutters. Three tournaments
have been organized and then trophies were distributed.

Mini 4WD to Drive
Japanese Maker Community Mini 4WD (4-wheel-drive) or Mini Yonku has been a well-liked hobby, especially among
Japanese children, since the 1980s. These battery-powered plastic tiny race cars are a lot like slot cars, But they run on the
track without a remote control. Mini 4WD racers typically customize their cars by adjusting the motors, bumpers, tires and
wheels to make them run more rapidly.

Mini 4WD for every person
Partakers in the mini 4WD race were sorted out into three classes depending on the level of customization. While starters
joined a practicum to customize their car bodies before the race, but some others with more design experience had already
3D Printed their cars using 3D Printers and laser cutters. There were also some modern professional designers. Here are
two pieces created by professional industrial designers Mitsuki Nishikawa and Jungsam Park. Mitsuki’s KIRIE depicts the
beauty of Japanese paper art (kirie literally means paper cut-out in Japanese).

Ovation for Japanese Engineers
The participants have to get it in their mind that if the car goes extremely fast, off the track and fail to negotiate the ongoing
movements than it could be disqualified. These 3D Printed bumpers placed in the middle of the route made the race
spectacular by kicking the fastest cars out of the track. It had a built-in meter to calculate the number of motor revolving and
limit the car’s speed when turning a curve.
The Honda team won the 3D printed trophy. The tournament ended in evening. The audience reacted with a loud cheer
when one of the Honda Team’s laser-cut mini 4WDs crossed the finish line to be the final champion.
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The next round of the FabCafe Mini 4WD Cup has been scheduled to be held in March 2015. If you are a mini 4WD lover in
Japan, you can test-run your vehicle at FabCafe Shibuya, utilize their 3D Printers or even ask them to check your 3D
models. We are looking forward to seeing even more unique 4WD cars next time.
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Twilight render version 2.0 for sketchup
Debamoy Ghosh
Twilight render is a photo-rendering plug in of Trimble SketchUp. Twilight puts power directly into Sketchup, making the
model lively. It is now in news that Twilight render version 2.0 for SketchUp is all ready to release.

The benefits
•
•
•
•
•

No more need to export your models into awkward, midway formats.
No indistinct geometry or lost texture.
All the rendering would be completed directly inside the SketchUp using multiple biased and unbiased
render methods for unparalleled control.
There will not be any fussing with complicated render settings or senseless numbers.
You can decide from a number of intuitive and powerful "Easy" render settings right at your fingertips.

The expectation is high for the Twilight render version 2.0 for SketchUp. It has been redesigned from the ground up, faster,
friendlier, and more feature-full than ever. Experts are expecting that Version 2 to be a huge asset for every workflow from
hobbyist to professional.
The maker of this software has reserved all the features from Version 1 and supplementary new ways to render, new
materials, and new tools.
The makers of this software are hopeful to continue to provide SketchUp with an excellent product and an escalating toolset.
Purchasing a permit for Version 2 will enable one to free upgrade to all the new Version 2 features in each release.

Faster rendering: The rendering will be completed 50 per cent faster. With the most up-to-date Kerkythea rendering backend, your renders will complete much faster. Post processing can be performed with hardware acceleration (for supporting
hardware) bringing advanced post processing effects almost right away.
Cleaner redesign interface: It has a redesign interface which takes up less space. Editors were separated by job to let you
concentrate on hand, Render, Animation, Batch Processing, and more. Popup controls give you single click access to all
tool features, then disappear to leave the workspace clean.
Exploration render Real-Time: Our new Exploration Renderer routinely modernize your render viewpoint to match your
SketchUp camera. The light, material, and environment editors are all ready with previews to show you your changes in a
range of scenes.
The Twilight render version 2.0 fetch you commanding new Post-Processing tools so you can achieve more inside
SketchUp and have better manage over your last product. Our post-production operations are performed straight on the
high-dynamic range data so a designer get better results and more detail than from an outside picture editing programme.

63 | P a g e

Arup Engineers has developed the world’s first ever WikiHouse in London
Debamoy Ghosh
The first ever open source, digitally-printed 3D house alias WikiHouse is going to be constructed in central London. Arup
engineers has developed this two-storied, two-bedroom house.
The WikiHouse is a low-energy house that can be downloaded, accommodated, printed and accumulated in a limited period
of time under £50,000. No construction skill is required to build it.
If anybody wants to learn the bit-by-bit processes for creating its own 3d printed house, then visit www.wikihouse.cc/
One can start with downloading house designs produced and distributed by a global organization of designers.
Afterward, apply the WikiHouse plugin for SketchUp. One can produce a set of cutting files for the house parts. The parts
are then 'printed' from a standard sheet material like plywood, with the help of a CNC milling machine.

The next phase should be organizing the numbered parts on the ground and slicing them together like a jigsaw.
Under this process no bolts are required; wedges and pegs are used to fix the parts.
After completion of all the processes, one can invite friends and family over the 'barn-raising'. The lightweight frames can be
hoisted manually and attached into a house structure.
Once the basic house framework is prepared, significant elements like cladding, insulation, windows and, of course, a toilet
can be included.
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Magazine Details – The Creative team of Sketchup-ur-Space

Started in September 2010, Sketchup ur Space (SuS) was the first online magazine devoted to SketchUp, that
unique, innovative 3D design tool from Google. It holistically covers features, events, news, updates, reviews
and many tips and tricks.

Rajib Dey: rajib@sketchup-ur-space.com
Rajib, the editor-in-chief of SketchUp ur Space magazine is the main writer. He is
responsible to write the cover story, blog and many other columns. Along with it, He is
creating a liaison between the writers and the readers.

Manoj Kumar Singh: manoj@jobs2india.com
Manoj is enthusiastic helps to put the content of the SketchUp up Space magazine in
the html version. Manoj is the html developer who beautifully creates each and every
edition with care along with the PDF version.

Abhishek Mondal: abhishek@jobs2india.com
Abhishek is the designer-in-chief of this magazine with the help of his creativity
Sketchup ur Space has gotten a classy as well as trendy look...

Debamoy Ghosh: debamoy@jobs2india.com
Pouring the confidence to budding 3D modelers is a challenge, which makes them
believe that they can create a universe. I try to bring exciting stories that not only
riveting read but put them the right technical path. After all, every right action needs
believe and determination for fulfillment.
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